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Software Usage Agreement
Silhouette America Corporation ("Silhouette America") hereby grants the purchaser and authorized User (the "User") the right to use the software 
(the “Software”) in accordance with the terms and conditions specified. By its purchase and/or use of the Software, the User hereby accepts and 
agrees to abide by the terms and conditions set forth herein.

1. Copyrights
All copyrights relating to the Software and accompanying printed materials such as manuals shall be retained by the individuals or organizations 
indicated in the Software or printed material.

2. License
The User may use the Software on one computer at a time.

3. Copying and modification
(1) The User may copy the Software for backup purposes. 
(2) The User may not modify, combine, amend, or otherwise adapt the Software by any means, including disassembly and decompiling.

4. Third-party use
The User may not transfer, assign, or otherwise dispose of the rights relating to the Software or its use to third parties.

5. Warranty
(1) Should the Software not operate correctly due to physical defects in the Software installation CD, contact Silhouette America. The Software 
CD will be exchanged in the case of a physical manufacturing defect, or a link to download the software will alternately be provided at Silhouette 
America’s discretion.
(2) Silhouette America only guarantees the CD under the above situation.
(3) Silhouette America provides the Software on an “as is” basis. Neither Silhouette America nor the supplier guarantees the performance or 
results that may be achieved using the Software and accompanying documentation. Neither Silhouette America nor the supplier gives any explicit 
or implicit guarantees regarding the infringement of a third party's rights arising from the use of the Software or accompanying manuals, their 
commercial performance, or their suitability for specific purposes. Neither Silhouette America nor the supplier assumes any responsibility for 
incidental, secondary, or special damages resulting from the use of the Software or accompanying manuals under any circumstances, including 
cases in which the possibility of that particular damage arising is indicated to the User by the retailer. Moreover, neither Silhouette America nor the 
supplier assumes any responsibility for claims from third parties.
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Registered Trademarks
The company names and product names described in this manual are registered trademarks of their respective owners.

Disclaimer
Some of the software images used in this manual are those that were used when the software was under development, and they may be slightly 
different from those actually displayed. There are no differences between the functions and setting layouts shown here and those of the actual 
version. 

About this Manual
This manual is intended to provide an overview on how to use the Mint Studio software. 

(1) The contents of this manual may not be copied in part or in whole without permission.
(2) The details and product specifications in this manual are subject to change without notice.
(3) The greatest effort has been taken to ensure the clarity and accuracy of the information in this manual. Please contact Silhouette America or 
your retailer with any questions you may have.
(4) Please note that Silhouette America assumes no responsibility for any liabilities arising out of the use of this manual and product.



Mint Studio   |   Chapter 1 - General Information 3

1 - General Information

1.1 System Requirements
The following system environment is required to use Mint Studio.
Operating System: 

Windows –Vista/7 (32-bit & 64-bit) 
Mac – OS X 10.6.8 or later

CPU: Pentium III 800 MHz or higher
Memory: 1GB RAM recommended
Monitor: 1024 x 768 True-color recommended (compact button mode available for notebook computers)
Mouse and/or Graphic Tablet
CD-ROM drive (for installation)

1.2 Features Overview
The Mint Studio software includes, but is not limited to, the following software features and benefits:

•  Imports a variety of file formats
• Download exclusive digital content
• Organize and optimize the library collection of images
• Manipulate Text with:

o Word and letter wrapping
o Alignment justification
o Letter spacing control
o Fit text to path

• Resize images to exact specifications
• Un-group/Group sets of lines for manipulation
• Edit and manipulate points of text and images
• Erase image parts with freehand eraser tool
• Weld images together
• Create shadowed mat effects
• Arrange images with following abilities:

o Transform
o Rotate

• Unlimited “Undo” and “Redo” actions
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1.3 Software File Formats
The Mint Studio software uses a proprietary .MINT file format, which consist of vector art for line and color/gradient fill type data Mint Studio also 
is able to open* the following file formats:

• STUDIO
• STUDIO3
• TIFF
• JPG
• BMP
• PNG
• GIF

In addition to files that may be opened or imported, Mint Studio can also access font. 

1.4 Available Digital Content
The Mint Studio software comes pre-loaded with 50 ready-made designs.  These become available as you connect and power on your Mint.

SAMPLE

Additional content is available through the Silhouette Design Store (accessed through the Mint Studio software). The Design Store will allow you 
to access and purchase additional digital content for the software, available both from Silhouette America artists as well as independent artists 
and various companies, thus ensuring a variety in look and feel of available pre-made content.  Further information on the store and downloading 
content will be provided later in this manual.
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2 - Installing Mint Studio
2.1 Installing on PC
1. Insert the installation CD into your computer’s CD-ROM drive. 

2. Windows Vista, Windows 7, and 8 users: You may need to allow permission to run the installer program that is automatically launched, or select 
to Run SilhouetteInstaller.exe if given the option to do so.

3. When the installer is launched, click Next to proceed.

4. The license agreement will then be displayed. Carefully read and review the information provided and then click on Yes to continue the 
installation process.

5. Continue to follow the prompts to install to the desired directory and complete the installation process.

NOTE FOR WINDOWS USERS ONLY: Upon hooking up the USB cord from the Silhouette Mint to your computer and powering on the Silhouette unit, you may be prompted with 
a “New Hardware Wizard” to install a driver. You may proceed to automatically find and install the driver as located on the installation CD.  The driver is not required for proper 
operation of the Mint Studio software, but may be installed to resolve the Windows automatic “Plug and Play” feature of prompting to install a driver for the hardware whenever 
the Silhouette is powered on.

2.2 Installing on Mac
1. Insert the installation CD into your computer’s disc drive.

2. Drag and drop the Mint Studio program into your Application folder to launch the installation process.

3. As the program is initially launched, the license agreement will be displayed. Carefully read and review the information provided and then click on 
Yes to continue to complete the installation process.
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3 - Basic Software Overview
3.1 Opening the Software
To open the software on PC, locate the desktop icon and double-click. If a desktop icon was not created during installation, go to the Windows 
Start menu and select to run Mint Studio.

To open the software on Mac, open the Applications folder and launch Mint Studio. 

The Mint Studio icon will appear as follows:  

When you open Mint Studio, a homepage will appear that will allow you to navigate to different locations within the software. Click Design to begin 
designing.

Once opened, the software should show an available starting stamp and workspace as shown below:
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3.2 Software Sections
The software offers several sectioned areas. Details as to each button’s specific function are discussed in later sections. However, so that you may be 
familiarized with where everything is located, a brief overview is provided for each of the sections.

General Stamp Management

 
This section along the top left-hand side of the screen is for general stamp management functions, such as opening, saving, and sending stamps to a 
printer.

Standard Editing Tools

  
 
This section along the top left-hand side of the screen is for basic copy/paste/cut and undo/redo actions commonly found in many programs.

Zooming Tools
 

This section along the top left-hand side of the screen is for basic zoom-in or zoom-out functions to view parts of the stamp from a closer 
perspective or at a more distant range.
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Mint Studio Tools

The section along the top right-hand side of the screen provides a range of tools for adjusting images, text, stamp size, and filters.

Drawing Tools
This section along the left-hand side of the screen provides tools used for selecting, and drawing images as well as the ability to drop text 
directly into your workspace area.

Library and Store Tools
This section along the left-hand side of the screen provides tools used for accessing the library and Design Store section.

 

Image Manipulation Tools

This section along the bottom of the screen provides a range of tools for applying strokes and fills, previewing colors, and deleting elements.
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3.3 Cutting/Drawing Area
You will note there are two different sections in your workspace:

• White workspace
• Grey holding area
 

The white workspace notes the active stamp area. Images may be placed or drawn onto this area, or they may be placed or drawn in the grey 
holding area. Any images in this grey area are invisible to your Mint or printer. 

3.4 Opening Stamps
Though opening the software will always provide you with a new stamp, you may select a new workspace to start a new project at any time. To start 
a new stamp you may either use the New option from the File menu, or select the New icon:
 
To open existing files you may either use the Open option from the File menu, or select the Open icon:
 
You will then be prompted to navigate to the location where your desired file is located. Through the Open feature, the Mint Studio software has 
the ability to open the following files:

• MINT (Mint Studio files)
• STUDIO (Silhouette Studio files)

The Open feature can also access simple image file types to be turned into stamps.

A list of recently used stamps may also be accessed from the File menu under Open Recent.

You may also use the Merge option from the File menu to open any file into the same workspace you are using rather than opening a new stamp 
workspace.

Finally, compatible file types may also be accessed by dragging the saved file from your computer directly onto your workspace in the software.
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3.5 Stamp Tabs
Each new stamp or opened stamp will provide you with a new stamp tab at the bottom left hand corner of your screen.

The tab will be labeled as “Untitled” until you save your file with a name, or if you have opened a file that already had a name, in which case the 
file’s name will be displayed. The white tab will always be the active stamp while all other opened inactive stamps will be grey. You may click on any 
inactive tabs to make it the active workspace and toggle between open stamps. Clicking on the “X” will close any open workspace.

3.6 Stamp Settings
The size and orientation of your stamp design area can be selected under ‘Stamp Settings’. Stamps may be viewed in Landscape or Portrait 
orientation. 

Stamp sizes are always stated in millimeters and can be found printed on your stamp sheet. For example, the numbers ‘1560’ in the image below 
indicate that the stamp is 15mm x 60mm (or 60mm x 15mm) in size.

Workspaces can be rotated to portrait or landscape views as needed.
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3.7 Viewing and Zooming
Often as you view your workspace, you may either wish to zoom in to get a closer look at smaller images or parts of an image that may be more 
difficult to work with.

Zoom In
 This tool will zoom into the center of your workspace for a closer view.

Zoom Out
 This tool will zoom out from your view for a more broad perspective.

Selection Zoom

This tool will allow you to zoom to specific areas of your workspace by drawing a box around the area you wish to zoom into.

Drag Zoom
After clicking on this tool, your icon will appear as the Drag Zoom icon above. You may then click and hold down your mouse to zoom in or 
out manually to any selected scale.

Pan

This tool allows you to adjust the on-screen position of your workspace. 

Fit to Page
 
Clicking the Fit to Page icon will immediately fit the full defined workspace to the center of your screen.
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3.8 Preferences
There are a number of user-controlled options that may be found in the Edit menu (PC) or Mint Studio menu (Mac) under Preferences. 

General
This section allows you to manually select the program language and how often you may wish the program to check for available software updates 
automatically. This section also provides preferences regarding units of measurement displayed in the program. You may adjust the following:

• Unit of Length – Adjust all displayed measurements to desired unit.
• Dimensions – Turn on or off image’s measurement properties as images are selected.

Display
This section provides display options including: 

• Anti-aliasing – Helps smooth jagged lines as they are created and viewed. Higher sample rates will increase the smoothness of lines. The “off” 
setting will produce rougher edges, but increases drawing speed.

• Button sizing – Allows for larger or smaller buttons to be displayed. 

• Animation – Controls speed of animating actions, such as images being moved on undo or redo actions, or during zooming in and out. Can be 
adjusted to “Instant” to turn animations off.

• Curve Quality – Enhances the visual appearance of lines on screen. Does not affect actual cut quality.

Selection
This section provides preferences for adjusting how the program selects images or how various drawing tools either continue to draw or finish upon 
completion of using the drawing tools.

Silhouette Devices
Controls how Silhouette models are detected when connected to the computer.
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Advanced
This section provides additional advanced options. In this section, you may adjust the following:

• Restore Factory Defaults – Resets all preferences.

• Reindex My Library –Performing this action will re-index the library to ensure corruption or errors may be resolved should you experience any concerns 
with your library loading properly or being able to use the library’s Search function properly.

• Set Library Permissions – Allows library to be properly accessed according to computer account permissions.

• Restore Pre-loaded Designs –Restores pre-loaded designs according to the Silhouette model detected.

• Reset Library – This action will remove all images and folders from your library and reset the library back to its original software installation 
settings.

• OpenGL Settings – Attends to select display issues. 

• HTTP Sockets – Depending on your internet connection speed, this option may be adjusted to a higher number of sockets to increase the 
download speed when purchasing images from the Design Store.

• IME Setting – Allows for typing of non-western characters.

• Proxy Settings – Used for proxy connection setups.
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4 - Drawing/Editing Images

4.1 Basic Drawing Tools
Mint Studio allows users to draw and create images very easily through a set of basic drawing tools. All drawing tools are located on the left side of 
the software screen.

Shape Tool

The Shape Tool allows for the creation of a variety of pre-made shapes. Some shapes can be adjusted further using the sliders within the 
shape.

Frame Tool
The Frame Tool allows for the creation of a variety of pre-made frames. Holding down the Shift key on your keyboard while drawing will 
create a frame with a width equal to its height, while holding down the Alt key on your keyboard will make the initial cursor point where 
your image is started as the exact center of your object. Some frames can be adjusted further using the sliders within the frame.

Line Tool
 The Line Tool allows for the creation of single straight lines. Holding down the Shift key on your keyboard while drawing will force a straight 

vertical, horizontal, or 45-degree increment line from the start point.

Smooth Freehand Tool 
The Smooth Freehand Drawing Tool allows for the creation of a smooth, continuous free-form line. Lines drawn with this tool will have 
smooth transitions and no sharp angles. Lines drawn with this tool will continue until the mouse button is released, or the image is closed 
by aligning the end point with the start point. 
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4.2 Editing Images
All line points on images may be edited, if changes to the existing image are desired. 

Select Tool
The Select Tool determines which image is selected as the active image and allows you to move images around on your screen. This is your 
default tool to click on images to show they are selected.

Edit Points 
To enter Point Editing Mode, you may either double-click on a selected image, or right-click the image and select ‘Edit Points’ from the menu.  This 
tool will allow you to edit any points of your image to move them around or remove them. Only single ungrouped line selections may be edited. 
Ungrouping will be discussed in later sections.

To exit the Point Editing Mode, you may double-click on your image again, or return to the regular select mode by clicking on the Select tool.

Point Editing Mode
When you enter the Point Editing Mode, selected images will change from displaying the resizing and rotating control handles around the image 
to showing the points, or nodes, of the image. Points on lines are where the line may take a new direction or change from being flat (or straight) to 
being curved.

                        Regular Selection Mode             Point Editing Mode

In Point Editing Mode, the selected point will be displayed in white while all other points will be dark grey. The selected line associated with the 
selected point will be emphasized as a bolded red line. Additional lines that have blue points are handles to adjust curved lines.

In Point Editing Mode, you will also be shown the Point Editing toolbar on the right-hand side of the screen. You may do the following actions in 
Point Editing Mode:
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Move/Adjust Points
Move a point by hovering with your mouse over any point on the line. Once over a point that may be edited, the cursor will adjust to show you 
may click and grab the point to move it to any desired location. With curved lines, you may similarly grab the blue points and drag them around the 
screen to adjust the curve of the associated line segment.

Add Points
Add a point by hovering over the line where no points currently exist where you may wish to drop a new point to edit your image. Once over a line 
where a point may be dropped, the cursor will be adjusted to show you may click to drop a point onto the desired line location.

Delete Point
 Any selected point will be deleted by using the Delete Point tool, or by right clicking on the selected point and choosing the Delete Point 

option. Deleting a point will cause the closest points on either side of the deleted point to join and create a new connecting line. Note that 
this tool is different from deleting an image and is only intended to delete individual points. It will only be available while in Point Editing 
Mode.

Break Path
 You may break the path of any line point by using the Break Path tool, or by right clicking on the selected point and choosing the Break Path 

option. Breaking a path will create two new points from the originally selected point where the path was broken.

You will note that a broken path, or two unconnected end points of opposite ends of the same line, may be re-joined by dragging one end   
    point onto the opposite end point of the image.
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Corner
 The Corner tool will allow a selected point to be so that the control handles at the selected intersecting point can be adjusted each 

individually to create a sharp corner.

Smooth
 The Smooth tool will allow a selected point to be adjusted to make a smooth transition point at the selected intersecting point.

Make Flat 
The Make Flat option will adjust the selected line (the line emphasized in bold red that is associated with whichever currently selected 
point) to a flat, straight line.

Make Curve
 The Make Curve option will adjust the selected line (the line emphasized in bold red that is associated with whichever currently selected 

point) to a curved line.

Simplify 
Some library images or other imported images from other sources may contain a very large number of points. The Simplify tool will 
automatically re-adjust the image’s points and simplify the image to its simplest possible point form while maintaining the image’s original 
overall line form.
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Aside from the tools found in Point Edit Mode, images can be edited using the following tools:

Eraser Tool
 You may erase any part of any image using the Eraser tool to easily and immediately remove inner parts or edges of the line image. 

Crop Tools
 You may segment images using the Crop tool. Within the Crop tool, you can select from pre-made templates or a variety of knife tools to 

segment your image to your liking.

Magnet Trace

Under the Crop menu in Mint Studio, there is a feature called Magnet Trace. It will 
help you easily crop your image around curved and uneven lines.

To use, select Magnet Trace and pick a starting point at the edge of the image you want to trace. Click once to create an initial point. Then guide 
the green line (the magnet) a little farther along the edge of the image and click again. This will create another point. The magnet will cling to the 
image, making it easy for you to guide the individual points to exactly where you want them to be. 

Clicking multiple points close together will give you a more precise crop around your intended area. Guide your magnet along the image and keep 
clicking.  
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Magnet Tracing with a large magnet size selection circleMagnet Tracing with a small magnet size selection circle

Adjust the magnet size selection circle by adjusting the slider or the up and down arrows under the Magnet Trace option, or by using the scroll 
feature on your mouse. The smaller the circle, the more precision you will have with placing your points. The larger circle is better for placing points 
far apart on long flat surfaces. 

You can adjust your circle size while you are Magnet Tracing your image so you can get more detailed precision at certain places. A smaller magnet 
is good in curves, corners, and more detailed places while a bigger magnet is ideal for larger areas with more straight lines. 

Once you connect your points into a complete shape, Mint Studio will crop out everything in the background. Don’t worry if you don’t have a 
perfect image. You can use Point Editing to make any adjustments to your cropped image. 

To make an adjustment, double click the image to enter Point Editing mode. Select the point or points that didn’t cling well to your image and drag 
the point closer to your intended image to adjust the Magnet Trace. 

The cropped portion of your image isn’t really gone. It is still available in the background and you can adjust your cropped image to include more of 
the original. You can do this by double clicking and entering the Point Editing mode. Pull the points out to reveal more of the original background. 
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4.3 Fills and Outlines
Designs in the program, including text, images created using the drawing tools, and library images, may be altered to have different properties.

Closed images (where the starting point of the line connects with the ending point of the line) can have a fill applied as well. 

You can apply an outline, fill, or both by selecting your design and choosing one of the icons below:

The Outline icon will create an empty outline around the selected shape. If using a filter, the outline will take on the properties of the 
selected filter. The outline can be adjusted in the Line Style menu.

The Fill icon will fill your selected shape if it is a closed image. The fill will take on the properties of the selected filter (if applicable).

The Fill Outline icon will combine the properties of both the Fill icon and Outline icon. Any filter used will be applied to both the fill and 
outline.
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Line Style Options
 Within the Line Style menu, you may adjust the style of your line to be a solid (default) or dashed style line. Lines will accordingly be cut or 

printed in the selected style.

Lines are viewed in point sizes regarding their width. The point size may be adjusted to any desired specification. While line width may be 
adjusted, the line will always be cut or sketched in a fixed width; that is, according to how thick the blade or pen is that you are using. 

Line thickness may be adjusted by either manually dragging the Thickness option bar or by typing in the desired point thickness.

The Corner Style option will adjust how lines appear at any of the image’s corner points where Corner is a sharp edge whereas Rounded will be a 
smoother edge.

The End Cap Style option will only adjust lines that have open ends. Flat or Square provide varying sharper flat edges at the line tip whereas 
Rounded provides a smoother rounded edge to the line tip.

Stamp Filters
 A variety of filters make it easy to apply a range of effects to your stamp. Multiple filters can be used on the same stamp, but only one filter 

can be applied to each selected shape. Some filters can be fine-tuned by using the slider bars within the filter menu. All filters can be 
inverted so that the negative and positive space of the stamp is switched.

4.4 Previewing Colors
You can preview how a finished stamp might look by applying a color or colors from the swatches along the bottom of the software. Multiple colors 
can be used on the same stamp, but only one color can be applied to each selected shape. Most of the swatches are for visual representation only 
and do not affect or alter how the stamp is actually printed. However, it is important to note that any shape colored with the white swatch will not 
be printed on the final stamp.
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5 - Text
Mint Studio has the ability to utilize any font that is installed on your computer.  You do not need to install these fonts into the program. Mint Studio 
will simply access all installed font files and display them for you as you go to create your desired text.

5.1 Creating Text

To use your fonts, click on the text tool located on the left-hand side of the software screen.
 
Clicking this will allow you to place a text cursor onto your workspace and begin typing directly onto the screen. 

The blinking line is your cursor to show where you are typing. You may back up or move forward by either clicking your mouse or using your 
computer’s right and left arrow keys. 

The surrounding green box is your text box. This box may be adjusted by clicking and holding the bar on the right edge of the text box. Dragging this 
bar to the left will allow you to wrap your text. Dragging this bar to the right will allow you to bring text back toward being on a single linear path. 

You may double-click or click outside of the text to exit the Text Editing Mode. You may return at any time to re-edit any words or letters by double-
clicking again on your created text.
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5.2 Manipulating Text
During the creation of your text, the Text Style menu will be opened on the right-hand side of your screen providing multiple adjustment options.

Available Fonts
The first section of this menu will display the current selected font with additional font options that are installed on your computer you may scroll 
through. The top of this section may be used to search for any specific font by typing in a font name if it is known.

You may change fonts during the Text Editing Mode and use a new font within the same text box with other fonts. Different fonts may also be 
applied to existing text or letters during Text Editing Mode by highlighting the desired string and selecting the newly desired font. If you are not in 
Text Editing Mode, new fonts may still be applied to selected text, but such adjustments will change the font for the entire selected text box.

Font Characteristics
 Some fonts are programmed to enable the use of certain style characteristics allowing you to bold, italicize, or underline text 

or letters. These characteristics will only be highlighted to be available for selecting if the font in question is programmed 
with that characteristic and such characteristics can be applied. To apply one of these characteristic, you may highlight the 
intended letters or words and then click on the available characteristic.

  
While Bold, Italic, and Underline options are displayed, if there are any additional available options programmed for the 
selected font, a scroll bar will appear on the right-hand side of this option box allowing you to scroll down and view whatever 
other options may be programmed.
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Text Justification

While text will be automatically be justified to the left, if your text is wrapped on multiple lines, you may alter 
your text justification as desired.

Text Size
Text size will always default to 36 point size. This refers to the font’s printed font size. Though fonts vary as they are programmed by a wide variety 
of sources, this will generally equate to roughly a  0.5 inch height (or 13 mm). The most common point sizes for print-format fonts are included in 
the available drop-down list, though any custom number may be manually typed into this size preference.

 
Other common equivalent measurements in the list include:

18 pt = 0.25 inch (6 mm)
24 pt = 0.33 inch (8 mm)
48 pt = 0.66 inch (17 mm)
72 pt = 1 inch (25mm)
144 pt = 2 inches (50 mm)
288 pt = 4 inches (100 mm)

Again, these measurements are approximations and will vary from font to font, so if you are seeking to obtain a specific measurement, you may 
wish to alternately re-size your text to your desired specification after creation.
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Character Spacing
Letters may be adjusted from their normally programmed spacing to either bring them closer together or push farther apart with the Character 
Spacing option.

 

Spacing will always start at 100% indicating spacing between characters are normally distanced. As the number is lowered or the bar is slid to the 
left, letters will come closer together. As the number is raised or the bar is slid to the right, letters will become spaced farther apart.

Line Spacing
If your created text is wrapped to multiple lines, you may similarly increase or decrease the Line Spacing option to adjust the distance between lines 
of text.

 

Spacing will always start at 100% indicating spacing of lines are normally distanced. As the number is lowered or the bar is slid to the left, text lines 
will come closer together. As the number is raised or the bar is slid to the right, text lines will become spaced farther apart.
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5.3 Text to Path
As text is created, or while in Text Editing Mode, you will find a control point located on the left-hand side of the text being created:

 This control point may be dragged to rest directly on any line path within your workspace. For 
example, you may create an oval with the Circle tool and then drag your text onto this line to 
achieve an arced effect:

As text is applied to a path in this manner, you will note a vertical bar to the left of the text. This allows for a new control bar which can be used to 
adjust the placement of your text relative to the line onto which the text has been applied so that it may be placed on, above, in line with, or below 
the path.

5.4 Curved Text
There is a selection of common text path shapes in the ‘Curved Text’ menu. To use them, first select the text you want to manipulate and then 
select a shape from the Curved Text menu.
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6 - Manipulating Images
There are many tools in Mint Studio allowing for basic and advanced manipulation of images and text. The following section provides an overview 
for all of these included tools and how they may be used.

6.1 Basics
Like most any software program, Mint Studio has a set of common basic editing tools as follows:

Selecting
Images may of course be selected by clicking on them. Multiple images may be selected by holding down the Shift key on your computer keyboard 
and clicking on another image. You may repeat this action to select as many images as desired. Holding down the Shift key and clicking on an image 
that is already selected will de-select that image.

Multiple images may be also be selected by clicking above an image and dragging your mouse to enclose all 
desired shapes to be selected at the same time. As you hold your mouse button down and drag your mouse, you 
will see a dashed line creating a selection box showing what you are selecting. Upon letting go of your mouse, all 
enclosed images in this box will be selected together in the same bounding box.
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Copy/Paste/Cut Tools 
These tools perform the basic expected actions of copying selected images, pasting them, or cutting them from view. Images 
copied or cut will reside in your computer’s memory on a virtual clipboard. You may only have one object on this clipboard at a 
time. This means if you copy one image and then copy another, only the most recent image will be waiting on the clipboard to 

be pasted. These actions may be accessed from the top tool bar, in the Edit menu, or by right-clicking on an image, as well as by using standard 
shortcut keys for these actions.

Pasting copied images will place the copy directly to the right of your original image so you may easily see and find your copy. An additional Paste in 
Front option is also provided to be able to paste a copy of an image directly on top of itself and is found in the Edit menu, in the right-click menu for 
the selected image, or by using standard shortcuts for this action. 

Delete
Selected images may be deleted from your workspace by clicking on the Delete button located along the bottom of the software screen, by 
accessing the Edit menu and selecting Delete, right-clicking a selected image and choosing the Delete option, or by simply pressing the 
Delete key on your computer keyboard.

Undo/Redo
Any action taken, including simply moving an image, may be undone. To back up to the previous action taken, click the Undo button. 
There are an unlimited number of actions you may go back to with the Undo button, including going back to when you first opened 
your new workspace.

Similarly, you may click the Redo button to repeat any actions you may have undone. You may continue to use this button until you return to the last 
action taken.
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6.2 Grouping/Ungrouping
These two actions are commonly used and are invaluable tools for helping to manipulate and adjust images. To understand these concepts we must 
first understand what grouped and ungrouped images are.

The following is an example of a single line:

 While the image may have many parts, it is still just one line with a single starting point and end point.

The following is an example of a multiple line image:

This image has two line sets with the body of the leaf and stem being one part and the inner details of the 
leaf being another. This image is grouped together so that if moved around on your screen, you do not have 
to move the outer line of the leaf and then move the center part independently and try to align it inside.

While it is not necessarily important to know exactly how many line parts an image has, it is important to 
understand that single line images are not grouped together with anything, while anything that has multiple 
parts is or can be grouped.
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Grouping
Any two sets of lines can be grouped together so they are fixed in their relative positions, even if moved, by using the Group option.

To use the Group option, select two or more images at the same time. Right-click the selection and click ‘Group’ from the menu. 

Ungrouping
Any image that contains more than one line set can be ungrouped so that parts of the image may be treated independently, removed, rotated, 
resized, or otherwise manipulated rather than having to manipulate the image as a whole.

For example, you may wish to cut out this cake image, but want to ungroup the image in order to remove some of the inner decorations of the 
image:

Once ungrouped, the image will be displayed showing individual selection boxes 
around each new ungrouped image part that can now be manipulated:
 
To access the individual ungrouped parts, you may deselect your image.
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6.3 Compound Paths
A compound path can be made (or released) within the ‘Object’ menu. The concept of compound paths is important in order to understand why 
certain attributes may be applied differently to seemingly identical situations. Compound paths are a collection of two or more line sets where inner 
lines are embedded into the image. A compound path may appear the same as a grouped set of lines, but is quite different in the way it will react to 
being filled with color, for example. 

Compound paths are only really a concern when you are creating print & cut images.

         Non-compound Image                              Compound Path Image

In the previous examples, the top two images are seen straight on and appear to be identical. However, when looking at the bottom set of images 
the differences become apparent. With the image on the left, from a side view we are actually looking at a grey butterfly with white spots resting on 
top. This is an image that is not a compound path. With the image on the right, from a side view we see that we are looking at a grey butterfly with 
white spots embedded into the image.

Of course, as we go to cut or sketch both images with the Silhouette, they will cut out in the exact same manner, but it is important to understand 
that there is a difference between these images as you may wish to achieve certain effects with filling images for print & cut applications. 
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 For example:

 This is the same image unfilled. All parts are grouped together.

If this is a non-compound image and it is filled with a color feature, this will be the result:

Even though grouped together, all line sets are still just individual pieces lying on top of each other, so they are all filled 
with the selected fill effect.

If this image has a compound path and it is filled with a color feature, this will be the result:

The unfilled parts of the image cannot be filled with compound path images because these embedded areas are negative 
space.

Compound paths can still be ungrouped to move multiple image parts around, but the action of ungrouping will 
immediately release the compound path and make it a non-compound path image

To make a series of multiple selected images a compound path, you may right-click until the multiple parts are all selected 
and select Make Compound Path. Similarly, you may right-click on a compound image and select Release Compound Path 
to perform the opposite action. These options may also be found in the Object menu.
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6.4 Rotating

Objects may be rotated to any desired angle. Selected images will always appear with a green rotation handle-bar 
that may be manually grabbed and rotated using your mouse.

The Rotate menu options will also provide additional rotation options for more exact or specific rotation options.
 
Within the Object menu, you may select any of the following options found under ‘Rotate’.

Rotate By
These options will rotate the selected image by the selected common angle from the image’s current angle.

Rotate To
These options will rotate the selected image to the selected angle based on the image’s original fixed 0° point.

Custom Rotate To
This option will allow you to either manually slide a degree measurement bar or enter a specific degree measurement and apply to rotate the 
selected image based on the image’s original fixed 0° point.
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6.5 Sizing
Objects may be sized to any desired measurement.

You will be able to view the measurement alongside your image as you draw or select images. 

There are also control points on the selection box for resizing images manually. To resize manually, simply click on 
any of these boxes and drag your mouse in the desired direction to make your shape larger or smaller. The corner 
control points will proportionately resize the image and maintain the relative height and width, while the side control 
points will stretch your image in the direction your mouse is dragged.

The Object > Scale menu options will also provide additional sizing options for more exact or specific rotation re-
sizing options.
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Within the Scale menu you may select any of the following abilities.

Scale
This option will allow you to resize a selected image to any specific measurement. The Lock Aspect Ratio option when checked will ensure your 
image is resized proportionately when only one measurement is being altered but you wish to maintain the image’s proportions. For example, if we 
take our original leaf example that started at 1 inch height by 2 inches width and adjust the width to 1 inch, you can see the following results:

 With Lock Aspect Ratio                            Without Lock Aspect Ratio

Fit to Stamp
You can scale your image to its maximum dimensions (based on stamp size) by clicking the ‘Fit to Stamp’ button in the scale menu or the ‘Fit 
to Stamp’ icon located along the bottom of the software screen
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6.6 Mirroring
Some materials or situations require images to be cut in a mirror image format, or you may simply want to flip objects around to achieve your 
desired image appearance.

To mirror an image, you may right-click any selected image to select the Flip Horizontally or Flip Vertically option.

No Mirror Effect Mirrored Horizontally

Mirrored Vertically Mirrored Horizontally and Vertically

Further mirroring options may be accessed in the Object menu under ’Mirror’.

In this menu, you may likewise flip your images around (as displayed above) under the listed Flip menu options.

You may additionally create mirror copies of selected images with the Mirror menu options, where you may create a mirrored copy to the left, to 
the right, mirrored above, or mirrored below. 

To mirror an image, you may right-click any selected image to select the Mirror Horizontally or Mirror Vertically option.

Original Image Mirror Copy Above Mirror Copy Below

Mirror Copy Left Mirror Copy Right
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6.7 Arranging
Multiple images may overlap each other. The order of which image is in front and which is in back can be arranged. The following options can be 
viewed by right-clicking a selected object:

Bring to Front
This option will take your selected image and move it in front of all other overlapping images. 

Original Image Order Circle Selected and Brought to Front
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Send to Back
This option will take your selected image and move it behind all other overlapping images. 

Original Image Order Triangle Selected and Sent to Back

In addition to these options, you may also right-click on an image and select Send Backward to send the selected image one level back rather than 
all the way to the back. 

Original Image Order Triangle Selected and Sent Backward

Similarly, you may right-click on an image and select Bring Forward to bring the selected image one level forward rather than all the way to the 
front.

Original Image Order Circle Selected and Brought Forward
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6.8 Aligning

Multiple images may be aligned in relation to each other. The following Align options are available under the ‘Object’ menu:

Centralize (Align Center-Middle)  

This option will center two or more selected objects so that they are lined up with each other in the middle of each other.

Align Left 
This option will align two or more selected objects so that they are aligned together to the left edge of the shared bounding box while 
maintaining their respective distances in regard to being above or below each other.

Align Center 
This option will align two or more selected objects so that their center points are aligned together while maintaining their respective 
distances in regard to being above or below each other.

Align Right 
This option will align two or more selected objects so that they are aligned together to the right edge of the shared bounding box while 
maintaining their respective distances in regard to being above or below each other.

Align Top
This option will align two or more selected objects so that they are aligned together on the top edge of the shared bounding box while 
maintaining their respective distances in regard to being next to each other.
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Align Middle 
This option will align two or more selected objects so that their center points are aligned together while maintaining their respective 
distances in regard to being next to each other. 

Align Bottom
This option will align two or more selected objects so that they are aligned together on the bottom edge of the shared bounding box while 
maintaining their respective distances in regard to being next to each other.

Space Horizontally
When a minimum of three objects are selected, this option will take all images and space them horizontally so that all objects are 
equidistant from each other horizontally.

Space Vertically
When a minimum of three objects are selected, this option will take all images and space them vertically so that all objects are equidistant 
from each other vertically.

Center to Stamp
This option will place the selected object or group of objects in the center of the stamp.

6.9 Welding 
Welding will take two or more selected overlapping images and join them together into one single continuous image. To weld a group of selected 
objects, right-click on the selection and click ‘Weld’.

Non-welded image with overlapping lines Welded image with overlapping lines removed
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7 - Library and Design Store
Mint Studio offers a library feature to keep and categorize all of your downloaded and user-created image for easy reference, as well as an 
Design Store to provide new content for users to download.

The library and store views may be found on the left-hand side of software screen and show which panel (workspace, library, or store) is the 
current selected active panel. 

7.1 Library
The library is where all of your pre-loaded and purchased content is contained and may be categorized, sorted, and accessed.

Viewing
You are able to view your images as icons by clicking on the Icon View option:

Library in Icon View mode

You may alternately view your library images in a list view to see more detail by clicking on the List View option:

Library in List View mode
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In List View mode you may sort your images by Name, Category, Artist, Date Downloaded, or Size by clicking on these column header titles.

In addition to how you view your library content, you also have the ability to adjust how your library is viewed as to whether you are viewing 
the library only or if you are viewing the library and your workspace. You will find these viewing options on the left-hand side of the software 
under library and Design Store buttons.

The top icon showing only one panel will display only your library or Design Store as they are accessed:

While the bottom icon showing two panels will display your library or Design Store along side your workspace:
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Accessing Library Content
To access library images, you may:

• Double-click on your image to open it onto your workspace

• Drag images from your library onto your workspace (only if your workspace is being displayed)

Categorizing & Library Management
As your library continues to grow with additional content, you may find it convenient to customize your library with new folders and sort images 
according to your liking.

You may add new custom folders by clicking on the Add Folder icon.
 

As new Untitled Folders are created, you may immediately name your folder to the desired name. Once your new folder has been created, you may 
drag and drop images into the folder. Right-clicking on a folder will allow you to create a new sub-folder for that selected folder, delete the folder 
(along with all contained content), or rename the folder.

In addition to customizing folders, you may also adjust any of your images within the library. Right-clicking on an image will allow you to delete the 
image, re-name the image, sort the images in the current folder, or show/hide the images properties. Image properties will provide you with the 
image’s description (as downloaded from the Design Store) and display any associated keywords.

As images or folders are deleted, they will be moved into the library’s Recycle Bin. You may still restore any of these images or folders by dragging 
them back into your library. However, once you have deleted any content from your Recycle Bin, this content will be permanently deleted from your 
computer.
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7.2 Silhouette Design Store
 The Silhouette Design Store provides additional downloadable content from not only Silhouette America, but also a variety of independent 

artists and contributing companies. The Silhouette Design Store can only be accessed from within the Mint Studio software and requires an 
Internet connection. 

The Silhouette’s “Purchase Online” shopping section is accessible at any time, 24 hours a day, 7 days a week.
While images may be purchased individually to customize your library experience, subscription options are also available for a monthly fee. Further 
information on subscriptions may be found in the Silhouette Design Store. 

All images are provided with the following benefits:

• You may download images using any major credit card, through download cards, or by using subscription credits

• Indefinite usage (you do not have to be connected to the Internet to access once purchased)

• Recoverable (in case of computer crash or replacement)

• Resizable and customizable to your specifications (using Mint Studio tools discussed in previous sections)

Download Cards
Silhouette America offers download cards which provide download credit valid toward any of the store’s download content you may wish to 
purchase and add to your library. You will find two codes on the back of each card. In the lower right-hand corner is the card’s identification number. 
Behind the silver security strip is the actual download code. It is a 16-digit code.
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Logging into the Store
Upon accessing the Silhouette Design Store by clicking on the Silhouette Design Store button, you will be brought to the store’s homepage.

You may sign in, or sign up for an account if you do not already have one created, by clicking on the link in the upper right-hand corner noting that 
you are not signed in.

To create an account, you will need to provide your name, your email address (which will be your log-in name), and any desired password. 
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My Account Options
Once logged into your account, you will find a link in the upper right-hand corner called My Account which will provide you with tools to manage 
your account. You will have the following options:

Change My Account Information – This will allow you to alter your email and password. 

My Download History – This will allow you to view a copy of all orders placed. When viewing specific orders, you may also opt to recover a specific 
order if there was any break in connection during the download process.

Recover All Downloaded Designs – This will allow you to recover any and all previously downloaded content if you are seeking to load the software 
onto a new computer in the case your computer has crashed or you are simply replacing your computer. 

Add a Download Card to My Balance – This is where you may enter any download card codes to apply the available balance onto your account. 

Manage My Credit Cards – Allows you to manage any credit card information on file used to pay for subscriptions or individual purchases.
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Shopping
You are free to browse all available Silhouette images without any obligation to purchase. You will find a navigation aide on the left-hand side of 
your shopping window. As categories are selected or as you search for images, you will also find related suggestions listed.

As you browse through the different themes and releases or make specific searches, once you find an image you would like to download, you may 
either add it to your cart by clicking on the add to cart option:

 

Or you may click on the shape for additional details and listing of similar or related shapes you may be interested in as well.

Note that images that have already been purchased cannot be added to your cart and will show that you already own it.
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Downloading
You may continue to browse and add additional images until you are ready to check out. Once you are ready, you may either click on the my 
cart link in your mini cart preview, or click on the cart icon in the upper right-hand corner of the shopping window.

When you are ready to download, simply click the Checkout button. If you have a balance on your account from a download card or 
subscription credit, the total charges will be taken from your balance automatically. If you do not have a balance or your account balance does not 
cover the total of the images you are seeking to purchase, you will be prompted to either provide credit card information or add a download card 
code to your account.

Once ready, you will be prompted for your password to authorize your purchase. Upon entering your password to confirm the purchase, the library 
will appear in a panel above the store and you will be able to view your images as they are downloaded into your library. 
 

You may then continue to navigate through the Design Store, or close it as desired. Once your images are all downloaded, you may then drag 
them from the recent download section and sort them as desired into any of your library folders. Downloaded images will remain in this Recent 
Downloads folder until sorted.

You will note that while all purchased images are stored in your library, purchased fonts will also be referenced in the library in a special “My Fonts” 
section. You many then either access these fonts purchased through the Design Store by double-clicking on these from the library, which will bring 
you to your workspace with a text cursor ready to place to type, or by access your fonts as previously discussed in section 5. 
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Recovering Images
Silhouette America maintains a database of all Silhouette users and their download histories. In the event of a computer crash or computer 
replacement, after re-loading the software onto your new computer, you may log into your Silhouette user account with your email address and 
password. Once logged into your account, you may go to the my account options to select Recover All Download Designs.

If you have multiple computers you own (such as a desktop and a laptop) and are simply seeking to recover your most recently purchased images 
to a secondary computer, rather than using the Recover All option, you may visit your My Download History in your account options to access a 
list of your previous purchases. In this section, you may click on any previous order number and recover your order. Again, you may only perform 
individual order recoveries to a limited number of computers which you expressly own.
Using the recovery features will not, of course, recover any user-created designs you may have created. Only downloaded images purchased 
through the shopping section may be recovered. You may back-up your user-created designs by simply locating where you have saved your user-
created files and saving them onto a disc or other storage device.

Silhouette America does regulate the number of unique computers you log into and reserves the right to suspend or remove accounts of registered 
Silhouette users whose account activity may be suspicious or indicative of public file sharing.
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8 - Saving
After you have created an image or stamp layout, you will have a variety of options to save your images.

Save
 The Save option is the basic saving function to allow you to create a STUDIO file and save to any location on your computer. These files may 

be backed up on any removable memory device.

Save As
This option found in the File menu will allow you to name your image as it is saved. It is saved to any specified location on your computer and can 
be backed up to a removable or external memory device as desired.

Save to Library
This option found in the File menu will save your file into the Library in Mint Studio. Upon selecting this option, you will be prompted to enter the 
name, keywords (which will become searchable upon re-indexing the library, as found under the Advanced Preferences), a description, the artist, 
and the shape’s category type. Upon saving images to your library, they will be added to a section labeled My Own Designs in the Library. These 
images cannot be navigated to on your computer for manually backing them up, so it is highly recommended to also save a copy of any images 
using the regular Save option.
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Further Support Contact Information
Further support information may be obtained through the following sources:

Web: www.silhouetteamerica.com
Email: support@silhouetteamerica.com
Phone: 800.859.8243 (Toll-free U.S. & Canada only)

Silhouette America, Inc. is based out of Lehi, Utah and is open M-F 8am to 5pm (Mountain time).

The specifications, etc., in this manual are subject to change without notice.
________________________________________

January 6, 2016 - 2nd edition
Silhouette America, Inc.
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